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eCatalogs
Electronic product catalogs, also known as eCatalogs, are data files in STEP that contain product and price
information for a specific product selection, typically stored in a product collection.

eCatalog Elements
An eCatalog object consists of three elements:

A collection of the products go into the eCatalog. A collection can be either dynamic or static.
A price list, which contains the prices that are valid for the eCatalog. A price list consists of product with its
terms. A term for a product is a combination of a value and a set of conditions such asMinimumQuantity,
MaximumQuantity, Start Date, and End Date.
An eCatalog configuration, which specifies the output format, the deliverymethod, and themapping between
internal product attributes and the attributes of the export format.

eCatalog Price Lists and Commercial Data Lists
Price lists used in eCatalogs are identical in format to the price lists used for commercial data in Print Publisher.
They contain the same elements (Value, Unit, Quantity, Dates), use the same default SystemSetup commercial
object type of Price (Price), and aremapped identically in the Import Manager. The difference between the two is
in their intended output. eCatalog price lists are intended for electronic output, and commercial data lists are
strictly used in Print Publisher print publications.

Since eCatalog price list import configurations aremapped using commercial data options in the Import
Manager, the term 'commercial data' is frequently used in this guide to refer to the contents of eCatalog price
lists. For more information on commercial data, refer to the Commercial Data section of the Publisher (Adobe
InDesign Integration) documentation.

© Stibo Systems - Internal - 2024.3 - September 2024 4



Creating an eCatalog
To create a new eCatalog, follow these steps.

1. In the Tree, select eCatalogs.
2. Right-click and selectNew eCatalog.

3. In the Create eCatalog dialog, enter an ID andName for the eCatalog, then clickCreate.

4. The eCatalog is created.
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The next steps are to add the following elements to your eCatalog:

A price list that contains the prices that are valid for the eCatalog.
A product collection that contains a list of all the products that go into the eCatalog.
An eCatalog configuration that specifies the output format, the deliverymethod, and themapping between
internal product attributes and the attributes of the export format.

© Stibo Systems - Internal - 2024.3 - September 2024 6



Creating a Price List
A price list consists of terms. A term for a product is a combination of a value (price) and a set of conditions such
asMinimumQuantity, MaximumQuantity, Start Date, and End Date.

The first step when setting up your eCatalog is to create a price list that holds the prices of the eCatalog.

1. In the Tree, select the eCatalog that you want to create a price list for.

2. Right-click, and then clickNew Price List.

Note: The STEP object type used for eCatalog price lists, Price (Price), is the same default object type
used for Commercial Data price lists. If you are also using Commercial Data in your system, any
configurationsmade to the Price object type (e.g., setting an ID Pattern) will apply to eCatalog price lists.
Additionally, the eCatalog price list cannot have the same ID as a Commercial Data list that uses the Price
object type. For more information on Commercial Data, refer to the Commercial Data topic of the
Publisher (Adobe InDesign Integration) documentation.

3. In theCreate Price List dialog, enter an ID and aName for the price list, then clickCreate.
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4. On thePrice List tab, the following optional settings are available.

Immutable:When checked, this setting prevents commercial data from being updated.

Act as selection list: Enable this option to have the products included in the price list serve as the
product selection for the eCatalog. If a collection is added to the eCatalog, the collection serves as the
product list, and this option will be disabled. For more information on adding a collection to an eCatalog,
refer to the Selecting Products for eCatalogs topic.

Import Configuration: Specifies the import configuration to be used for the price list. Click the ellipsis
button ( ) to select the saved import configuration.

Currency:Click the ellipsis button ( ) to choose a currency unit for the list. This selection can be any unit
and does not have to be currency.
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Note: This does not place the unit on price lists values. To have the unit display within terms lists, the
unit must be added when defining the import configuration bymapping the values of an Excel column
to the 'Unit' aspect of the terms list. Refer to the Creating an eCatalog Configuration topic for more
information on creating import configurations.

Last modification time:Displays the date and time that the list was last modified. This field is non-
editable.

Expiry date: Enter an expiration date for the list, or double-click the field to open the Date Picker.

Note: The price list will not expire automatically. The date is for administrative purposes only and is not
the same as the 'End Date' value that can be defined for individual terms. Refer to Creating an
eCatalog Configuration for more information on the 'End Date' value.

Default Start-date and Default End-date: Like Expiry date, these values are for administrative
purposes only and are not the same as the 'Start Date' and 'End Date' values defined for individual terms.
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Defining Import Settings for Price Lists
eCatalog price list terms (commercial data) are imported into eCatalog price lists using standard Import Manager
functionality.

After creating a price list object for your eCatalog, the next steps are to create a sample import file, in Excel or
CSV format, then define the import settings for importing actual price data. The columns in the sample file will be
used tomap fields in the Import Manager wizard, which will allow the system to later ingest a sheet that contains
actual data.

Sample Excel Price List Load File
The following two screenshots show examples of price list import files, one containing price break and quantity
information, and the other one containing price break, quantity, unit, start date, and end date information.

Price Example

This example sheet is an Excel file that contains 10 columns and 8 products. Each product has three priceswith
price breaks that change based on the quantity of the product being sold.

For example, using the first product row shown in the above screenshot (ID = 121171), the price breaks are as
follows:

Break No. Quantity Price

1 1 - 3 2.79

2 4 - 9 1.79

3 10 - 100 0.89
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Note: To only import a price file with three prices, youmust set theMinimumandMaximum values (even if
they are fake values) to each of the prices. You cannot just load three columns of prices and nothing else. To
load three price breaks, youmust load nine columns of data. Unit, Start Date, and End Date are optional.

Prices with Units and Dates

To also import Unit, Start Date, and End Date values, which are optional, a corresponding column for each value
must also be present on the sheet. In the below example—which shows columns for 'Price1' only—there is a
'P1Unit,' 'P1StartDate,' and 'P1EndDate' column. Each subsequent price (Price2, Price 3, and others) will also
have its own unit, start date, and end date columns.

Note:When importing units, theSTEP ID of the unit must be used and not the symbol. In the below
example, iso4217.unit.USD is the STEP ID for U.S. dollar ($).

Creating an Import Configuration for a Price List
The following steps for creating a price list import configuration use a sheet that contains columns for all available
price list (commercial terms) elements: value, unit, quantities, and dates. These steps assume that you have
already created a sample file. Throughout the Import Manager, the elements within the price list (terms) are
referred to as commercial data.

1. In the Tree, expand the relevant eCatalog.

2. Select and right-click the price list that you want to import prices to, and then clickEdit import
configuration.
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3. The Import Manager displays on the Select Data Source screen.

Note: All steps of the Import Manager wizard, and the options available for each step, are described in
detail in the Creating a Data Import topic of the Data Exchange documentation. The information in this
topic only contains detailed descriptions of the steps that are of particular importance to commercial data.

4. On this screen, select File. The data source will always be File for commercial data import configurations.

5. While still on the Select Data Source screen, click the ellipsis button ( ) next to the Filename field and
choose the sample upload file, then clickNext.

6. On the Select Format screen, the format will be prepopulated with either Excel or CSV, depending on the
format of your sample sheet.

7. Make any additional configurations ('HasHeader,' 'Trimwhitespace,' 'Use date and number formatting from
sheet'), then clickNext.

Note: It is strongly recommended to keep the default selection of 'no' for 'Use date and number formatting
from sheet', especially if importing date values. This ensures that date values are standardized into an
ISO format. Refer to the Excel Format topic of the Data Exchange documentation for more information.
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Mapping Commercial Data in the 'Map Data' Step

In theMapData step, a number of mappingsmust be specifiedmanually. The 'AutoMap' feature will not work for
commercial datamappings, though it can be used tomap the ID or Name columns. ID is required.

1. To start themappings, click a source column, then clickMap. TheMapColumn to dialog displays.

2. Select the column tomap, then clickMap. TheMap to dialog displays.

3. In this example, the first column has already beenmapped to ID; the first price column, 'Price1,' has been
selected; and the Commercial Data radio button has been selected in theMap to dialog.
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4. The name of the price list will display in the Data Set field.

5. From theGroup list, select the preferred quantity break.

6. Choose one of the following options to determine which field of the commercial list that the data from the
Excel sheet should bemapped to:

SelectValue to map the column to the value field.

SelectUnit to map the column to the unit field and have the unit display along with the term value.

SelectMin. Quantity to map the column tominimumquantity in the selected group or price break.

SelectMax. Quantity to map the column tomaximumquantity in the selected group or price break.

SelectStart Date to map the column to the start date when the price becomes valid.

SelectEnd Date to map the column to the end date of the selected group or price break.

7. Check theMandatory box if you want rowswithout a term value to be skipped on import so none of the
information that may be related to a product without a specified term value will be imported. ClickOK.
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8. Follow the previous steps until all columns of the sheet aremapped. For example, in this sheet, after mapping
the 'Price1' column to Commercial Data > Group: 1 > Value, the remaining columnswill bemapped as
follows:

The 'P1min' columnwill bemapped to Commercial Data > Group: 1 >Min Quantity

The 'P1max' columnwill bemapped to Commercial Data > Group: 1 >Max Quantity

The 'P1Unit' columnwill bemapped to Commercial Data > Group: 1 > Unit

The 'P1StartDate' columnwill bemapped to Commercial Data > Group: 1 > Start Date

The 'P1EndDate' columnwill bemapped to Commercial Data > Group: 1 > End Date

The 'Price2' columnwill bemapped to Commercial Data > Group: 2 > Value, and so forth.

The remainder of the columnswill follow the same pattern.

9. ClickNextwhen finished.

Completing the Import Configuration

1. On the Identify Objects screen, if the products in the source file are not identified as existing products in the
system, the 'Match Result' will be 'New.' ClickNext.

2. On the Identify Destination screen, several options are available, which are detailed at length in the Import
Manager - Identify Destination topic in the Data Exchange documentation. For the purposes of commercial
data imports:

Reject Updates should be left unchecked, since a setting on the Advanced Settings screen of the wizard
will control how commercial lists are updated.
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3. On the Select BusinessRules screen, business rules can be specified to run upon import if required for your
business needs. For more details, refer to the Import Manager - Select BusinessRules topic in the Data
Exchange documentation. ClickNext.

4. On the Advanced Settings screen, any options can be selected based on your business needs, but the only
options relevant to commercial data appear in the Replace/Update Options area.

To delete all existing content of the commercial list(s) and replace it with the content of the new file, select
'Replace entire existing list(s) with content of import file'.

To keep the existing content of the commercial list(s) and only replace the commercial data of the product
IDs included in the new file, select 'Only update commercial data for objects included in import file'.

For more information on all options available on the Advanced Settings screen, refer to the Import Manager -
Advanced Settings topic in the Data Exchange documentation.
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5. ClickFinish to complete the wizard. The Save Import Configuration dialog displays. It is recommended to
save the import configuration and check 'Don't import now' in case changes need to bemade to the
configuration before importing live data. ClickOK.

Refer to the Running a Data Import topic in the Data Exchange documentation for information on how to save
the import configuration.

6. The price list import configuration is saved in the specified classification structure as an XML file of the object
type Import Manager Configuration (stibo.ImportManagerConfig).

7. A price list can now be imported. Refer to the Importing Prices topic, for details.
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Editing a Saved eCatalog Import Configuration
Tomake changes to an existing eCatalog import configuration, do the following.

1. Right-click on the price list and select 'Edit import configuration'.

2. The Import Manager wizard displays, starting on the 'Select Data Source' screen.

3. Make the desired edits following the same steps listed above for creating a new configuration.

4. Alternatively, you can edit the configuration by right-clicking on the saved import configuration object in the
classification hierarchy. Refer to theMaintaining a Saved Import Configuration topic in the Data Exchange
documentation for details.
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Importing Prices
eCatalog price lists are imported using standard Import Manager functionality. In STEPWorkbench, these
imports can be initiated fromSTEPWorkbenchmenu (i.e., File > Import > Data) or from the price list object itself.
This topic explains how to import commercial data information for eCatalog price lists through a right-click action
on the price list object.

To import eCatalog price information:

1. Right-click on the price list object and select Import Data.

2. In the 'Import Commercial Data' dialog, click the ellipsis button ( ) next to 'Filename', then navigate to and
select the file you want to import.

Note: This file must match the format of the file saved in the import configuration.
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3. In the 'Replace/Update Terms' area, select one of the following options:
To delete all existing content of the commercial list(s) and replace it with the content of the new file, select
'Replace entire existing list(s) with content of import file'.

To keep the existing content of the commercial list(s) and only replace the commercial data of the product IDs
included in the new file, select 'Only update commercial data for objects included in import file'.

The choice youmadewhen defining the import configuration on the Advanced Settings screen of the Import
Manager wizard will be set as default, but you can override this option by selecting the other option.

Note: If 'Immutable' has been checked on the price list object, values cannot be updated regardless of
what option is chosen. Refer to the Creating a Price List topic for more information.

4. Select 'Import on-line' radio button if you want the process to run and show the result online instead of going
to a background process. Once the process completes, the Import Report window will show the complete
report.

5. ClickOK.
To view the imported data, use one of themethods outlined in the Viewing and Searching Price Lists topic.
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Viewing and Searching Price Lists
After importing a price list, the commercial data terms can be viewed both from the price list and from the product
that is included in the list. Additionally, the data can be searched when viewing it from the product.

View Terms from a Price List
1. Navigate to and select the relevant price list in your eCatalog.
2. On the 'Price List' tab, expand the 'Contents of' area.
3. The contents of the price list are displayed.

Search Terms from a Price list

1. Navigate to and select the relevant price list in your eCatalog.
2. Select the relevant commercial list, then click the 'Price List' tab.
3. Expand the 'Contents of' area to view the content of the list.
4. In the Product field, enter a product name or ID, or use an asterisk to enter part of a name or ID, and then click

Search to display the results.
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5. To show the entire content of the list again, remove text from the search field and clickSearch.

View Terms from a Product
1. In the Tree, navigate to and select the relevant product.
2. On the Commercial tab, expand the Terms area.
3. All price lists that the product appears in are displayed. Any Publisher commercial data lists that the product is

linked to will also display. For more information on commercial data, refer to the Commercial Data topic in the
Publisher (Adobe InDesign Integration) documentation.
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It is also possible to edit terms lists from both locations. Refer to the Editing Price Lists topic for more information.
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Editing Price Lists
After being imported, eCatalog price list terms can be edited, either from a price list or from a product.

Note: Price lists cannot be edited if the Immutable box has been checked on the price list object. Refer to the
Creating a Price List topic for more information.

Edit Price List Terms from a Price List
There are two ways to edit price list terms from a price list. The Value and Unit can be edited directly from the list.
The Value, Min Quantity, MaxQuantity, Start Date, and End Date values can be edited by right-clicking on a
product in the list and accessing the Edit Terms dialog.

Editing Terms Directly

1. Navigate to and select the relevant price list, then click on the 'Price List' tab.
2. Expand the 'Contents of' section to view the content of the list.
3. Double-click in any Value field to edit the value.
4. Click the ellipsis button ( ) in the Unit field to edit the unit.

Editing Terms from the Edit Terms Dialog

1. Navigate to and select the relevant price list, then click on the 'Price List' tab.
2. Expand the 'Contents of' section to view the content of the list.
3. Right-click the first column next to the preferred term, then chooseEdit Term.
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4. In the 'Edit Terms...' dialog, double-click inside the field for the term that you want to edit, then clickOK when
complete.
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Add Terms to a Price List

1. Follow the steps outlined above to access the Edit Terms dialog.
2. Click theAdd Term link to add a new row to the Edit Terms dialog.

3. Enter the relevant term values in the new row, then clickOK.

Remove Terms from a Price List

1. Follow the steps outlined above to access the Edit Terms dialog.
2. In the Edit Terms dialog, right-click the first column next to the term you want to remove, then choose

Remove Term.
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Add Products to a Price List

Instead of importing products into a price list, you can add productsmanually, and you then can edit the terms.

1. Navigate to and select the relevant price list, then click on the 'Price List' tab.
2. Expand the 'Contents of' section to view the content of the list.
3. Right-click the first column next to one of the terms in the table, and then clickAdd Product. Alternatively,

scroll to the bottom of the table-based view, then clickAdd Product.

4. In the 'Add Product to Terms List' dialog, click the ellipsis button ( ).
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5. Browse to or search for the relevant product on the 'Select Product' dialog, then clickSelect. Only one
product can be selected; an option tomulti-select products is not available.

6. After selecting the product, clickNext.
7. In the 'Enter Terms' step, clickAdd Term to add a new blank row to the dialog.
8. Enter the relevant terms, then clickAdd Term again to addmore terms.

Note: No option is available in this dialog to add a Unit. It must be added after the product is added to the
list.

9. ClickFinish. The product is now available in the list.

Remove Products from a Price List

1. Follow the same initial steps as above for adding a product, but clickRemove Product instead of Add
Product.

2. The 'Remove Terms for...' dialog displays, showing all the terms that will be affected.
3. ClickDelete to remove the product from the list.

4. Click the ellipsis button ( ), then either browse or search for a product, and then clickNext.

5. ClickAdd Term and fill in the relevant fields.
6. ClickFinish.

Edit Price List Terms from a Product
Price lists can also be edited from product objects that appear in at least one price list. When viewing terms lists
for a product on the Commercial tab, the Value and Unit can be edited directly. The Value, Min Quantity, Max
Quantity, Start Date, and End Date values can be edited by right-clicking on a terms list and accessing the 'Edit
Terms' dialog.
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Editing Price Commercial Data Directly

1. In the Tree, navigate to and select the relevant product.
2. On the Commercial tab, expand the Terms area. The content of the lists related to the product is displayed.
3. Double-click in any Value field to edit the value.
4. Click the ellipsis button ( ) in the Unit field to edit the unit.

Editing Commercial Data from the Edit Terms Dialog

1. In the Tree, navigate to and select the relevant product.
2. On the Commercial tab, expand the Terms area. The content of the lists related to the product is displayed.
3. Right-click the first column next to the relevant term, then chooseEdit Term.

4. In the Edit Terms dialog, double-click inside the field for the term that you want to edit, then clickOK when
complete.

Add Terms to a Product

Terms can be added to a product from the 'Edit Terms' dialog, or from the 'Add Term to Product' dialog. Follow
these steps to add a term from the 'Add Term to Product' dialog.

1. In the Tree, navigate to and select the relevant product.
2. On the Commercial tab, expand the Terms area. The content of the lists related to the product is displayed.
3. Click theAdd Term link at the bottom of the list. Or, right-click on the first column next to any term and select
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Add Term.
4. In the 'Add Term to Product' dialog, click the ellipsis button ( ).

5. In the 'Select Terms List' dialog, browse to or search for the relevant commercial list, then clickSelect to
close the dialog.

6. ClickNext to go to the 'Enter Terms' step, then click theAdd Term link to add a new row under Enter Terms.
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7. Enter the relevant terms, then clickFinish.

Remove a Single Term from a Product

1. Follow the steps outlined above to access the Edit Terms dialog.
2. Right-click the first column next to the preferred term, then chooseRemove Term.

Remove All Terms from a Product

Removing all terms from a product will remove the product itself from the terms list.

1. In the Tree, navigate to and select the relevant product.
2. On the Commercial tab, expand the Terms area. The content of the lists related to the product is displayed.
3. Right-click the first column next to the relevant term, then clickRemove Term.
4. The Remove terms for product dialog displays.
5. Verify that you want to remove the listed terms, then clickDelete. All the product terms are removed, and the

product itself is also removed from the list.
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Copying Price Lists
You canmake a copy of a price list and use it as a price list in a different publication. You can also copy price lists
to Publisher publications to use as commercial data lists. For more information on Commercial Data, refer to the
Commercial Data topic of the Publisher (Adobe InDesign Integration) documentation.

1. Navigate to the price list that you want to copy, then right-click and chooseCopy.

2. Navigate to and select the eCatalog that you want to copy the list to, then right-click and choosePaste.
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3. If the eCatalog already has a list, a warning dialog will display to let you know that the existing price list will be
deleted when you paste the new one. ClickOK to continue and overwrite the price list, or clickCancel to exit.

4. If the eCatalog does not already have a list, the Duplicate dialog displays.
5. Enter an ID and Name for the new list, then check theDuplicate terms box if you want to copy the actual

contents of the list.

6. ClickOK. The copied terms list is now present in the eCatalog.
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Selecting Products for eCatalogs
There are twomethods of selecting the products that should be part of an eCatalog:

Use the contents of the price list itself, which is achieved by selecting the 'Act as selection list' on the price list.
Refer to the Creating a Price List topic for more information.

Link a collection to your eCatalog.

In the workbench, collections can be created in two ways:

1. Using the Search tab, perform a search, and create a collection of the results. This creates a dynamic product
selection for the catalog that can later be refreshed.

2. Using an import file, create a collection of the contents. This creates a static product selection for the catalog.
If you later want to alter the product selection, you will have to delete this file-created collection and create a
new one.

For information on how to create a collection using either method, refer to the Creating Collections topic in the
Getting Started documentation.

Note: It is strongly recommended to use a dynamic collection created from a search, since this collection can
be refreshed every time the eCatalog is exported.

This topic explains how to add collections to eCatalogs.

Add a Dynamic Collection to an eCatalog Through Search
To add a dynamic collection to an eCatalog created from a search:

1. On the Search tab, search to locate the products that you want to be part of the eCatalog.

2. When the search is complete, click the 'Save asCollection' button .
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3. In the 'Save asCollection in Background Process' dialog, browse or search for the eCatalog that you want to
add the collection to.
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4. For the 'Collection Name' parameter, add a Name for the new collection (IDs are autogenerated).
5. A background process launches.When complete, the collection is added to the eCatalog.

Add a Static Collection to an eCatalog Through a File
To add a static collection to an eCatalog created from a file:

1. Right-click on your eCatalog and select 'Create Collection from File'.
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2. In the 'Create Collection FromFile' dialog, locate the file to be imported.

3. For the Collection Name parameter, add a Name for the new collection (IDs are autogenerated).
4. For the File Contains parameter, select if the import file contains IDs of products, classifications, or assets.
5. ClickOK to start a background processwhich will create the new collection.
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Creating and Editing an eCatalog Configuration
Another required step in creating an eCatalog is to add an 'eCatalog Configuration'. This is an export
configuration that specifies the data to be included in the eCatalog, as well as the data format of the eCatalog.

To create and configure an eCatalog Configuration:

1. Navigate to the relevant eCatalog, then right-click and selectNew eCatalog Configuration.

2. The 'Configure eCatalog' wizard displays on the 'Select Format' step. The Configure eCatalog wizard is
based on the Export Manager with added functionality, allowing you tomap the prices from the price list
information of the current eCatalog into the selected output format. You can choose among the following
eCatalog formats, which are supported via export options (each is described in the Data Exchange
documentation):

Excel Format:Files always include a header row and rows for data.

BMEcat Format: BMEcat 1.2 is an XML-based standard for electronic data transfer by electronic catalogs.

BMEcat 2005 Format: An XML-based standard for electronic data transfer by electronic catalogs.

Ariba CIF 3.0 Format: A simple comma-delimited list of catalog items and their attributes.

cXML Format: Exports data using Ariba cXML 1.2 and is an XML-based language designed specifically
for communication of e-commerce business documents.

xCBL Format: Exports data using the CommerceOne XML-based language.

Configure an eCatalog Configuration for Excel
1. On the 'Configure eCatalog' wizard 'Select Format' step, selectExcel from the dropdown list , then click

Next.

2. On the 'Map Data' step, click on the relevant information that you want included in the export (for instance,
<ID> and <Name>), then click the arrow button on the right side of the window to add it to the list of data to be
exported. At aminimum, youmust map ID and a price column.
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3. Tomap the required price data, expand 'Commercial (eCatalog)', select the relevant price list (in this
example, 'FallPrices'), then click the arrow button to add it as a column in the Excel sheet.

4. In the 'Enter Quantity Break' dialog that displays, enter the quantity break value (e.g., 1), then clickSave.

5. The price value ismapped, followed by the break number in brackets, e.g., [1].
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6. To apply transformations to the values that display in the export, expand the Price row to view the fields that
allow transformations via the transformation button ( ). Whenmapping a commercial value, the same

transformations are available for a product attribute, but the available aspects differ.

For more information on applying aspect transformations to outbound data, refer to the Aspect - Transform
Outbound topic in the Data Exchange documentation. For a broader overview on applying transformations to
outbound data, refer to the OutboundMapData - Transform topic in the Data Exchange documentation.

7. In the Header field, click the transformation button ( ) to change the header that will display in the Excel

export spreadsheet for the price value. In the 'Transformations' dialog, enter the desired header in the
'Source' field, then clickSave.

Note: If the header is not changed, then the header in the Excel sheet will be the same for all price
breaks, e.g., 'Price in FallPrices.' As such, it is recommended to customize the header for each break, for
example, 'Price in FallPrices - Break 1.'
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8. In the Value field, click the transformation button ( ) to apply a transformation to the values that display in

the price columns. The following Aspect selections are available:

Price - default; the value field from the commercial list

Currency - the unit from the commercial list

Price and currency - both the value and the unit from the commercial list

Currency ID - the ID of the unit from the commercial list

Min Quantity - theMin. Quantity value from the commercial list

Max Quantity - theMax. Quantity value from the commercial list

Start Date - the Start Date value from the commercial list

End Date - the End Date value from the commercial list

9. Repeat the process tomap values from additional price breaks. The following image shows a sample
mapping with ID, Name, and three price breakswith transformations applied:
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10. ClickNext on the 'Map Data' step when finished.

11. On the 'Advanced' step:

For information on the standard options available on this step, refer to the Export Manager - Advanced
topic in the Data Exchange documentation.

Additional options specific to eCatalog exports are highlighted in the below image.
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Use effective date: Select this option if you want the system to take the 'start date' and 'end date'
specified on the price list into consideration when exporting prices. 'Use effective date' ensures that
priceswill only be included in the export if the effective date lies within the specified period. Leave this
box unselected to have the system disregard the 'start date' and 'end date' applied to products on the
price list.

If selected, specify one of the following options:

Current date of when export is initiated: Select to ensure that the prices included in the export
have a start date that occurs on or before the date that the export is initiated. If the start date of a
price on the price occurs after the current date, then that price will not be included, since it is not yet
valid.

Effective: Select to ensure that the prices included in the export have a start date that occurs on or
before the date specified. Aswith the 'current date' option, if the start date of a price on the price list
occurs after the effective date, it will not be included in the export.

If no date span has been specified for the prices, the effective date will have no effect.
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Selfcontained references: Select this option if there is a need for the export to be self-contained. This
ensures that no referenceswill be allowed to point to anything outside of the export.

12. ClickNext to advance to the 'Select DeliveryMethod' step.

13. Select File, then clickFinish.

Configure an eCatalog Configuration for BMEcat
For full details on configuring all of the information required for a BMEcat export, refer to the BMEcat Format
topic of the Data Exchange documentation.

1. On the Configure eCatalog wizard 'Select Format' step, selectBMEcat from the dropdown.

2. Fill out any relevant fields on the step, then clickNext.

3. On the 'Map Data' step, the followingmandatory fields aremarked in red text with an asterisk: Supplier Article
ID, Short Description, Order Unit, and Price. Since this guide concerns eCatalogs, the Price field will be
mapped.

4. Tomap the price data, expandCommercial (eCatalog). Select the relevant price list (in this example,
'Price'), then click the arrow button next toPrice to add it as a column in the Excel sheet.

5. In the 'Enter Quantity Break' dialog that displays, enter the quantity break value (e.g., 1), then clickSave.
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6. The price value ismapped, followed by the break number in brackets, e.g., [1].

7. To apply transformations to the values that display in the export, expand the Price row to view the fields that
have the transformation button ( ) available. Whenmapping a commercial value, the same transformations

are available as for a product attribute, but the available aspects differ. The available aspects in the price
transformations for the BMEcat format are the same as those available for Excel exports. Refer to the above
subsection, 'Configure an eCatalog Configuration for Excel,' for more information.

For more information on applying aspect transformations to outbound data, refer to the Aspect - Transform
Outbound topic in the Data Exchange documentation. For a broader overview on applying transformations to
outbound data, refer to the OutboundMapData - Transform topic in the Data Exchange documentation.
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Note: Commercial (eCatalog) > Price values can bemapped to other fields other than 'Price.' For
example, You couldmap to the 'MinimumQuantity' field, then apply an Aspect transformation to pull the
'Min Value' value from the price list.

8. ClickNext on the 'Map Data' step when finished.

9. On the 'Advanced' step, additional options specific to eCatalog exports are included in addition to the options
available in the standard Export Manager. For information on the standard options available on this step,
refer to the Export Manager - Advanced topic in the Data Exchange documentation.

The additional options for eCatalogs are the same as those available for Excel exports (User effective date,
etc.). Refer to the above Configure an eCatalog Configuration for Excel section for more information.

10. ClickNext to advance to the 'Select DeliveryMethod' step.

11. Select File, then clickFinish.

Configuring eCatalog Configurations for Other Formats
The process for creating an eCatalog Configuration for other available formats (Ariba CIF 3.0, cXML, and xCBL)
is very similar to that for creating configurations for Excel and BMEcat exports. Though the available data fields
differ on the 'Map Data' step of the 'Configure eCatalog' wizard for each format, the process for mapping
Commercial (eCatalog) > Price is the same, and the available aspects for transformations are the same.
Additionally, the same options ('Use effective date,' etc.) are available on the 'Advanced' step.

Editing an eCatalog Configuration
1. To edit an eCatalog Configuration, right-click the configuration and selectEdit.

2. The 'Configure eCatalog' wizard displays. Follow the same steps as you would when creating a new
configuration.
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Exporting an eCatalog
1. In the Tree, right-click the relevant eCatalog, then selectExport eCatalog. The Export eCatalog wizard

displays on the Refresh Collection screen.
2. SelectRefresh before each run if you want the collection to be refreshed before each export. This option is

only relevant for collections created from a search. It does not apply if your collection was created from a list
or if you are using the price list as the product selection.

3. On the Schedule Process step, specify whether you want to export the eCatalog immediately or at a specified
time in the future, then clickNext. You have the following options:
Now: Starts the eCatalog Export process and delivers the eCatalog as specified in the eCatalog
Configuration.
Later: Schedules a single delivery in the future at the specified time and date.
Weekly: Schedules a recurring eCatalog export for one or more of the days of the week. This option
requires a time, a start date, and optionally an end date. If no end date is specified, the eCatalog scheduling
process runs until it is endedmanually.
Monthly: Schedules a recurring export of the eCatalog for a specific day of everymonth.
Later and repeat: Schedules delivery in the future at the specified time and date and at an interval given in
minutes.

Important: Consider the time zone of the application server compared to that of the workbench (the client)
where the schedule is created or viewed.When scheduling a job, the local time zone is displayed in the
workbench, but the time zone of the server is used to run the background process. Although displayed, the
time zone of the client is not included in the instruction to the server to run the job. This can cause confusion
about when the job will run since the scheduled time is not automatically converted to accommodate
potential differences in time zones.
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4. On the NameProcess, provide a name for the process. An auto-generated name is provided, but you can
change it to make it easier to identify the process.

5. ClickFinish to either start the export process or a scheduling process, depending on the specified settings.
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